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Purpose

This document provides instructions for configuring the Media System 
Administration client.

Intended Audience

This document is intended for Voyager customers who have purchased Media 
Scheduling.

Reason for Reissue

This user’s guide is being reissued for the following reasons.

• Added the section Preferences for Exiting Media System Administration 
Using the X Icon on page 1-4 that describes the new Display warning on 
module close preference option.

About This Document 
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How to Use This Document

This document consists of the following:

Chapter 1 “Getting Started
Chapter 1 provides an overview of using the Media System 
Administration client.

Chapter 2 Using Media System Administration
Chapter 2 describes the settings available in Media System 
Administration. This includes creating operators, media types, 
room types, equipment types, equipment group types, system 
policies and so on.

Appendix A Security Profiles and Policy Groups
Appendix A describes the settings available in Media System 
Administration. This includes creating operators, media types, 
room types, equipment types, equipment group types, system 
policies and so on.

Index The Index is an alphabetical, detailed cross-reference of topics.

Conventions Used in This Document

The following conventions are used throughout this document:

• Names of commands, variables, stanzas, files, and paths (such as 
/dev/tmp), as well as selectors and typed user input, are displayed in 
constant width type. 

• Commands or other keyboard input that must be typed exactly as 
presented are displayed in constant width bold type.

• Commands or other keyboard input that must be supplied by the user are 
displayed in constant width bold italic type.

• System-generated responses such as error messages are displayed in 
constant width type.

• Variable portions of system-generated responses are displayed in 
constant width italic type.

• Keyboard commands (such as Ctrl and Enter) are displayed in bold.

• Required keyboard input such as “Enter vi” is displayed in constant 
width bold type.

• Place holders for variable portions of user-defined input such as ls -l 
filename are displayed in italicized constant width bold type.
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About This Document

• The names of menus or status display pages and required selections from 
menus or status display pages such as “From the Applications drop-down 
menu, select System-wide,” are displayed in bold type.

• Object names on a window’s interface, such as the Description field, the 
OK button, and the Metadata tab, are displayed in bold type.

• The titles of documents such as ENCompass Web Client User’s Guide are 
displayed in italic type.

• Caution, and important notices are displayed with a distinctive label such 
as the following:

NOTE:
Extra information pertinent to the topic.

! IMPORTANT:
Information you should consider before making a decision or configuration.

! CAUTION:
Information you must consider before making a decision, due to potential 
loss of data or system malfunction involved.

TIP:
Helpful hints you might want to consider before making a decision.

RECOMMENDED:
Preferred course of action.

OPTIONAL:
Indicates course of action which is not required, but may be taken to suit your 
library’s preferences or requirements.

Document Reproduction/Photocopying

Photocopying the documentation is allowed under your contract with Ex Libris 
(USA) Inc. It is stated below:
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All documentation is subject to U.S. copyright protection.  CUSTOMER 
may copy the printed documentation only in reasonable quantities to aid 
the employees in their use of the SOFTWARE.  Limited portions of 
documentation, relating only to the public access catalog, may be copied 
for use in patron instruction.

Comment on This Document

To provide feedback regarding this document, use the Ex Libris eService or send 
your comments in an e-mail message to docmanager@exlibrisgroup.com. 
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Getting Started

Introduction

This chapter describes the prerequisite installation and configuration information 
necessary for beginning work in the Media System Administration module.

For more information about using the Voyager Media Scheduling module, see the 
Voyager Media Scheduling User’s Guide.

Purpose of this Chapter

This purpose of this chapter is as follows.

• To provide instructions for opening and closing the Media System 
Administration module.

• To provide instructions for logging in and out of the Media System 
Administration module.

• To provide general instructions for using Help in the Media System 
Administration.

• To identify prerequisites for working with the Voyager Media System 
Administration module.



1-2  Ex Libris Confidential 10.2

Media System Administration User’s Guide

Prerequisite Skills and Knowledge

To use this document effectively, you need knowledge of the following:

• Basic Microsoft® Interface navigation

• Basic Voyager System Administration module

• Basic Voyager Media Scheduling module

Before You Begin

Before you begin, you must have the Media System Administration client 
installed.

Logging In

The procedure for logging in is shown in Procedure 1-1, Logging In, on page 1-2.

Procedure  1-1.  Logging In

Use the following to log in to Voyager Media System Administration.

1. Double-click the Media System Administration icon on your desktop from the Start 
menu.

Result: The Login dialog box displays. See Figure 1-1.

Figure 1-1. Media System Administration Login Dialog Box

2. Enter your ID and Password.

3. Click the OK button. 
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Result: The Media System Administration workspace displays.

Once you successfully log in to the Media System Administration module, you can 
begin to configure your policies and enter the information needed to control Media 
Scheduling activities.

Help

You can get help about Media System Administration by pressing F1.  For more 
detailed information, the following items are available on the Help menu.

Field Name Description

Help Topics Displays the table of contents for Media System 
Administration Help and opens the Help Window.

Endeavor on 
the Web

Connects to Endeavor Support Web or to Endeavor’s home 
page.

About 
System 
Administra-
tion

Displays the copyright notice and version number for Media 
System Administration.

Login Information

You can access the following login information by clicking File > Login 
Information:

• Operator name

• Operator ID

• Location

• Encryption (enabled/disabled)

• Server (as defined in the Server= parameter in the voyager.ini file)

• Database
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Figure 1-2. Media System Administration Login Information Dialog Box

Exiting Media System Administration

To close Voyager Media System Administration, select File>Exit from the main 
menu.

Preferences for Exiting Media System 
Administration Using the X Icon

The Media System Administration preferences (File > Preferences) provide an 
option for displaying a warning message when you close the Media System 
Administration module by selecting the X icon. 

Figure 1-3. Preferences for Exiting Media System Administration Using the X Icon
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With the Display warning on module close option selected when you select the 
X icon to close the module, the system prompts you with the options OK and 
Cancel to close the client or return to the active window, respectively.
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Using Media System Administration

Introduction

The Voyager Media System Administration module offers a wide variety of options 
for configuring Voyager Media Scheduling to reflect your library’s situation and 
policies.  You should decide with your colleagues what options fit your 
circumstances and what policies you want to encode into the system.  This allows 
you to configure Voyager Media Scheduling so that you can take full advantage of 
its power and flexibility.

No matter what kind of system you are coming from or whether you have 
previously used a paper system to track your media scheduling activities, your 
implementation can be as simple or as complex as your library policies. As you 
and your colleagues begin discussions about the various decisions you must 
make, this may be an excellent opportunity to rethink some policies and 
procedures to reduce complexity and thereby streamline your workflows. A paper-
based media scheduling process, for example, involves certain activities that are 
not required by a computerized system and may be eliminated from your current 
procedures.

You can also make changes to Voyager Media System Administration once you 
learn more about the system and have some first-hand experience with using the 
Voyager Media Scheduling module.
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Operator Security

The Operator Security list bar button (Figure 2-4) provides access to options that 
determine what permissions Voyager users have within Media Scheduling.

Figure 2-4. Operator Security Tab

You can control the following separate aspects of security.

• The information that is accessible.

• The people that can access it.

• What locations can be accessed.

Each operator who uses Voyager Media Scheduling must have an Operator 
Profile containing a name, Operator ID, and Password. Before using staff-side 
Voyager Media Scheduling, operators must login by typing in their Operator ID 
and Password. The link between an Operator Profile and a Security Profile lets 
the system know what functions the operator can and cannot perform in the 
Voyager Media Scheduling module.

Entering Information

When operators log in to the Voyager Media Scheduling module, they must type 
in their Operator IDs and Passwords exactly as they are entered here, including 
upper and lower case alpha characters, or their sign-on attempt is rejected. For 
example, if you enter "mEdia" as an Operator ID and Password the system rejects 
"media" or "Media" or any other variant typed at login. The system accepts only 
"mEdia."

Security Profiles

The settings in the Security Profile (Figure 2-7) determine, for anyone who is a 
part of that Security Profile, what types of activities can and cannot be performed.

See Security Profiles and Policy Groups on page A-1 for a description of the 
relationship between Security Profiles definitions and Policy Groups definitions as 
it relates to operator authorizations for Bookings and Inventory.
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Figure 2-5. Operator Security-Security Profiles

The procedure for creating a new Security Profile Name is shown in Procedure 2-
2, Creating a New Security Profile Name, on page 2-3.

Procedure  2-2.  Creating a New Security Profile Name

Use the following to create a new Security Profile Name.

1. Click the Security Profiles button (Figure 2-6) located on the Operator Security tab.

Figure 2-6. Security Profiles Button

2. Click the New button. 
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Result: The Security Profiles Settings dialog box displays.

Security Profile Settings

The Security Profiles Settings dialog box (Figure 2-7) is where you name and 
create a security profile that can be used in the Voyager Media Scheduling 
module.

Figure 2-7. Security Profile Settings Dialog Box

Operator Security Profile Settings

The Security Profile Settings dialog box allows you to configure the security 
settings for viewing, adding, updating and deleting the Voyager Media Scheduling 
equipment, equipment maintenance, room, item, patron, and booking records.  
The settings made in this dialog box are applied to the operator security profile 
currently being edited.

The levels of security shown in Table 2-1 on page 2-4 can be set individually for 
Equipment, Equipment Maintenance, Rooms, Items, Patrons, and Bookings.  

Table 2-1. Security Levels

Security Option Description

No Access Staff cannot view, add, update or delete 
records of that type
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Field Name Description

Equipment Select the desired level of security for equipment records 
from the drop-down menu (No Access, View, View/Add/
Update, View/Add/Update/Delete).

Maintenance Select the desired level of security for equipment 
maintenance records from the drop-down menu (No 
Access, View, View/Add/Update, View/Add/Update/Delete).

Room Select the desired level of security for room records from the 
drop-down menu (No Access, View, View/Add/Update, 
View/Add/Update/Delete).

Item Select the desired level of security for item records from the 
drop-down menu (No Access, View, View/Add/Update, 
View/Add/Update/Delete).Patron

Patron 
settings

Patron Select the desired level of security from the drop-down 
menu (No Access, View, View/Add/Update, View/Add/
Update/Delete).

Set Counters Select this checkbox if you want the security profile to 
include the ability to change or reset counters.

Bookings 
settings

Bookings 
security 
drop-down

Select the desired level of security from the drop-down 
menu (No Access, View, View/Add/Update, View/Add/
Update/Delete).

View Staff can view records but cannot add, 
update or delete records of that type

View/Add/Update Staff can view, add and update but not 
delete records of that type

View/Add/Update/
Delete

Staff can view, add, update and delete 
records of that type

Table 2-1. Security Levels

Security Option Description
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View 
Historical?

Select this checkbox if you want the security profile to 
include the ability to view booking histories.  

NOTE:
In order to view historical bookings, you must also have the 
Retain Patron ID for Media Booking History box checked.  
This retains a link between items and patrons in the Voyager 
Media Scheduling module.  If this checkbox is not set, 
historical bookings does not record which patron charged 
which media items.  See the System Administration User’s 
Guide for more information.

Charge? Click this checkbox if you want the security profile to include 
the ability to charge media items.

Discharge? Click this checkbox if you want the security profile to include 
the ability to discharge media items.

Renew? Click this checkbox if you want the security profile to include 
the ability to renew media items.

Block 
Override-
Patron?

Click this checkbox if you want your security profile to 
include the ability to override patron blocks.  

NOTE:
If the Block Override-All? box is checked, Block Override-
Patron is automatically checked.

Block 
Override-
Item?

Click this checkbox if you want your security profile to 
include the ability to override item blocks.  

NOTE:
If the Block Override-All? box is checked, Block Override-
Item is automatically checked.

Block 
Override-All?

Click this checkbox if you want your security profile to 
include the ability to override any blocks that occur in the 
Voyager Media Scheduling module.

Change 
Discharge 
Date/Time?

Click this checkbox if you want the security profile to include 
the ability to change discharge dates and times.

Remove 
equipment 
from booked 
rooms?

Click this checkbox to allow operator to move equipment 
from booked (pending, not currently charged) rooms.
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Locations

The Operator Security - Locations dialog box (Figure 2-8) provides options that 
you select to determine which groups of people by location have permissions to to 
execute different functions based on the settings (as saved in Operator Security 
- Security Profiles) for that group.

Figure 2-8. Operator Security-Locations

The procedure for editing location assignments is shown in Procedure 2-3, Edit 
Location Assignments, on page 2-7.

Procedure  2-3.  Edit Location Assignments

Use the following to edit location assignments.

1. Click the Locations icon (Figure 2-9) located on the Operator Security list bar.
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Figure 2-9. Locations Button

Result: The Locations workspace displays.

NOTE:
The list of location names that displays is dependent on the locations created in 
Voyager System Administration in System > Locations.

2. Select a location from the Location Name list and click Edit.

Result: The Change Location Assignments group box displays, and the name 
of the currently selected location is highlighted. See Figure 2-10.

Figure 2-10. Change Location Assignments group box

3. Check every box for every profile to which you want to allow access to the selected 
location.
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Result: This identifies the operator group permissions for each location.

NOTE:
To enable media booking requests through WebVoyáge, at least one of the 
operator groups must have permissions granted for the location identfied in 
Voyager System Administration as the default OPAC Circ Desk.  See Figure 2-
11.

Figure 2-11. Voyager System Administration OPAC Circ Desk example

4. Click the Close button when you are done making changes.

Result: This saves the option(s) that you selected

NOTE:
Any changes that you make take effect immediately. However, you may 
experience a lag between saving these options and the change taking effect while 
Voyager executes the change.
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Operators

The Operators workspace (Figure 2-12) lets you assign a security profile to each 
operator. Operators can be created and deleted only through the main Voyager 
System Administration module. You may assign only one profile to each operator.

Figure 2-12. Operator Security-Operators

The procedure for editing an Operators group is shown in Procedure 2-4, Editing 
an Operators Group, on page 2-10.

Procedure  2-4.  Editing an Operators Group

Use the following to edit an Operator’s group.

1. Click the Operators button (Figure 2-13) on the Operator Security tab.
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Figure 2-13. Operators Button

2. Select an operator from the list.

3. Click Edit.  

Result: The Change Operator Assignment dialog box displays.

4. Select a security profile from the Security Profile Name list.

5. Click Save or click Cancel.

Result: This saves or discards changes.

Media Scheduling

The Media Scheduling portion of the Voyager Media System Administration 
module allows you to configure the information you need for using your Voyager 
Media Scheduling module.  You can create and edit different categories or "types" 
of items, rooms and details that you can then use to keep your inventory in order 
and process bookings more swiftly.  You can use these to highlight important 
information that might be necessary to complete a booking.  

Click the Media Scheduling listbar (Figure 2-14) to display the icons for the tools 
on the taskbar.

Figure 2-14. Media Scheduling listbar
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Equipment Types

The Media Scheduling-Equipment Types window (Figure 2-15) is for entering your 
equipment type descriptions and codes to identify the kinds of equipment you are 
charging in your Media Scheduling sessions and all of the different equipment that 
is available to the patrons.  This tool also allows you to create Equipment Groups 
Types, so that you can also assign Equipment Groups with identical types of 
equipment to the same group.

Figure 2-15. Media Scheduling-Equipment Type Window

To access the Media Scheduling-Equipment Type window, click the Equipment 
Types button (Figure 2-16). 

Figure 2-16. Equipment Types Button
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Creating a New Equipment Type

The procedure for creating a new equipment type is shown in Figure 2-5.

Procedure  2-5.  Creating a New Equipment Type

Use the following to create an Equipment Type.

1. Click the New button. 

Result: The New Equipment Type portion of the window displays (Figure 2-17). 

Figure 2-17. Media Scheduling-Equipment Types (New)

2. Enter the media type description in the Type Description field.

3. Enter the code for the media type in the Type Code field.

4. Click the "Is this a group" checkbox if the type is going to refer to an equipment 
group.
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If the type is to refer to a kind of equipment, do not select the check box.

5. Click Save to save your changes to the database, or click Cancel to exit without 
saving. 

Editing an Equipment Type

The procedure for editing an equipment type is shown in Procedure 2-6, Editing 
an Equipment Type, on page 2-14.

Procedure  2-6.  Editing an Equipment Type

Use the following to edit an Equipment Type.

1. Click an Equipment Type Description to highlight it. 

2. Click the Edit button. 

Result: The Edit Equipment Type portion of the window displays.

3. Place your cursor in the Type Description field and re-type any information that you 
want to change. 

4. Place your cursor in the Type Code field and re-type any information that you want 
to change.

NOTE:
When editing an equipment type, the group or item condition cannot be changed.

5. Click Save to save your changes to the database; click Cancel to exit without saving.

Deleting an Equipment Type

The procedure for deleting an Equipment Type is shown in Procedure 2-7, 
Deleting an Equipment Type, on page 2-15.
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Procedure  2-7.  Deleting an Equipment Type

Use the following to delete an Equipment Type.

1. Click a Type Description to highlight it. 

2. Click the Delete button. 

Result: The Delete Equipment Type dialog box displays.

3. Click Yes to delete the Equipment Type; click No to retain the Equipment Type.

Media Types

The Media Types workspace (Figure 2-18) is for entering descriptions about the 
media types that your patrons use and to assign a unique code to each Media 
Type.

Figure 2-18. Media Scheduling-Media Types
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To access the Media Scheduling-Media Types window, click the Media Types 
button (Figure 2-19). 

Figure 2-19. Media Types Button

Creating a New Media Type

The procedure for creating a new Media Type is shown in Procedure 2-8, Creating 
a New Media Type, on page 2-16.

Procedure  2-8.  Creating a New Media Type

Use the following to enter a media type.

1. Click the New button. 

Result: The New Media Type fields display.

2. Enter the name for the type of media that you are creating in the Type Description 
field.

3. Enter the code for the type of media that you are creating in the Type Code field. 

4. Click the Save button to save your information to the database; click Cancel to exit 
without saving.

Editing a Media Type

The procedure for editing a Media Type is shown in Procedure 2-9, Editing a 
Media Type, on page 2-17.
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Procedure  2-9.  Editing a Media Type

Use the following to edit a Media Type.

1. Click a Type Description to highlight it. 

2. Click the Edit button. 

Result: The Edit Media Type workspace displays.

3. Place your cursor in the Type Description field and re-type any information that you 
want to change. 

4. Place your cursor in the Type Code field and re-type any information that you want 
to change.

5. Click Save to save your changes to the database, click Cancel to exit without saving.

Deleting a Media Type

The procedure for deleting a Media Type is shown in Procedure 2-10, Deleting a 
Media Type, on page 2-17.

Procedure  2-10.  Deleting a Media Type

Use the following to delete a Media Type.

1. Click a Media Type Description to highlight it. 

2. Click the Delete button. 

Result: The Delete Media Type dialog box displays.

3. Click Yes to delete the Media Type; click No to retain the Media Type.
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Maintenance Types

The Media Scheduling Maintenance Types activity (Figure 2-20) allows you to 
enter all of the kinds of maintenance you perform on your Media Scheduling items 
and everything that is associated with those items such as rooms and storage 
areas. 

Figure 2-20. Media Scheduling-Maintenance Types Window

To access the Media Scheduling-Maintenance Types window, click the 
Maintenance Types button (Figure 2-21). 

Figure 2-21. Maintenance Types Button
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Creating a New Maintenance Type

The procedure for creating a new Maintenance Type is shown in Procedure 2-11, 
Creating a New Maintenance Type, on page 2-19.

Procedure  2-11.  Creating a New Maintenance Type

Use the following to enter a media type.

1. Click the New button. 

Result: The New Maintenance Type fields display.

2. Enter the name for the type of maintenance that you are creating in the Type 
Description field.

3. Enter the code for the maintenance type that you are creating in the Type Code field. 

4. Click the Save button to save your information to the database; click Cancel to exit 
without saving.

Editing a Maintenance Type

The procedure for editing a Maintenance Type is shown in Procedure 2-12, 
Editing a Maintenance Type, on page 2-19.

Procedure  2-12.  Editing a Maintenance Type

Use the following to edit a Maintenance Type.

1. Click a Type Description to highlight it. 

2. Click the Edit button. 

Result: The Edit Maintenance Type portion of the window displays.

3. Place your cursor in the Type Description field and re-type any information that you 
want to change. 



2-20  Ex Libris Confidential 10.2

Media System Administration User’s Guide

4. Place your cursor in the Type Code field and re-type any information that you want 
to change.

5. Click Save to save your changes to the database; click Cancel to exit without saving.

Deleting a Maintenance Type

The procedure for deleting a Maintenance Type is shown in Procedure 2-13, 
Deleting a Maintenance Type, on page 2-20.

Procedure  2-13.  Deleting a Maintenance Type

Use the following to delete a Maintenance Type.

1. Click a Maintenance Type Description to highlight it. 

2. Click the Delete button. 

Result: The Delete Maintenance Type dialog box displays.

3. Click Yes to delete the Maintenance Type; click No to retain the Maintenance Type.

Media Room Types

The Media Scheduling Media Room Types activity (Figure 2-22) allows you to 
enter all of the types of rooms you have in your media center and university that 
you want to make available as a possible viewing location or pick-up location. 
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Figure 2-22. Media Scheduling-Media Room Types

To access the Media Scheduling-Media Room Types dialog box, click the Media 
Room Types button (Figure 2-23). 

Figure 2-23. Media Room Types Button

Creating a Media Room Type

The procedure for creating a Media Room Type is shown in Procedure 2-14, 
Creating a Media Room Type, on page 2-21.

Procedure  2-14.  Creating a Media Room Type

Use the following to enter a media room type.
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1. Click the New button. 

Result: The New Media Room Type fields display.

2. Enter the name for the media room type that you are creating in the Type 
Description field.

3. Enter the code for the media room type that you are creating in the Type Code field. 

4. Click the checkbox "Is this a storage room" only if you are going to use the room 
solely as a storage room. 

NOTE:
Checking this box prevents this room from being able to be booked.  Once set, 
this checkbox cannot be changed.  Do not check this box if you want to be able to 
use the room for anything other than storage.  

5. Click the Save button to save your information to the database; click Cancel to exit 
without saving.

Editing a Media Room Type

The procedure for editing a Media Room Type is shown in Procedure 2-15, 
Editing a Media Room Type, on page 2-22.

Procedure  2-15.  Editing a Media Room Type

Use the following to edit a Media Room Type.

1. Click a Type Description to highlight it. 

2. Click the Edit button. 

Result: The Edit Media Room Type portion of the window displays.

3. Type a new description into the Type Description field, or type a new code into the 
Type Code field.  The Is this a storage room checkbox cannot be changed.  To 
change it, you must delete this room type and create a new one.

4. Click Save to save your changes to the database; click Cancel to exit without saving.
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Deleting a Media Room Type

The procedure for deleting a Media Room Type is shown in Procedure 2-16, 
Deleting a Media Room Type, on page 2-23.

Procedure  2-16.  Deleting a Media Room Type

Use the following to delete a Media Room Type.

1. Click a Media Room Type Description to highlight it. 

2. Click the Delete button. 

Result: The Delete Media Room Type dialog box displays.

3. Click Yes to delete the Media Room Type; click No to retain the Media Room Type.

Media Room Detail Types

The Media Scheduling Media Room Detail Types activity (Figure 2-24) allows you 
to enter all of the main features of the rooms in your media center and university 
that you might need to know in order to decide on a possible booking location. 
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Figure 2-24. Media Scheduling-Media Room Detail Types

To access the Media Scheduling-Media Room Types window, click the Media 
Room Types button (Figure 2-25).

Figure 2-25. Media Room Types button

Creating a Media Room Detail Type

The procedure for creating a Media Room Detail Type is shown in Procedure 2-
17, Creating a Media Room Detail Type, on page 2-24.

Procedure  2-17.  Creating a Media Room Detail Type

Use the following to create a new Media Room Detail Type.
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1. Click New.  

Result: The New Room Detail Type box displays.

2. Type a name for the new type into the Type Description box.

3. Type a code for the type into the Type Code box.  

4. If this is to be a repeatable detail (i.e., if it can be added to a room description more 
than once), check the "Is this detail repeatable?" box.

5. Click Save to keep your changes and close the box; click Cancel to discard them.

Editing a Media Room Detail Type

The procedure for editing a Media Room Detail Type is shown in Procedure 2-18, 
Editing a Media Room Detail Type, on page 2-25.

Procedure  2-18.  Editing a Media Room Detail Type

Use the following to edit an existing Media Room Detail Type.

1. Select the profile you want to edit.

2. Click Edit.  

Result: The Edit Media Room Detail Type box displays.

3. Type a new name for the type into the Type Description box, or type a new code for 
the type into the Type Code box.  You cannot change the Repeatable? status.

4. Click Save to keep your changes and close the box; click Cancel to discard them.

Deleting a Media Room Detail Type

The procedure for deleting a Media Room Detail Type is shown in Procedure 2-
19, Deleting a Media Room Detail Type, on page 2-26.
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Procedure  2-19.  Deleting a Media Room Detail Type

Use the following to delete an existing Media Room Detail Type.

1. Select the type you want to delete.

2. Click the Delete button. 

Result: The Delete Room Detail Type dialog box displays.

3. Click Yes to delete the Media Room Detail Type; click No to retain the Media Room 
Detail Type.

Policy Settings

The Media Scheduling-Policy Settings activity allows you to configure matrix 
settings for rooms, equipment and items. The Policy Settings (Figure 2-26) allow 
you to configure things such as whether you can book an item or piece of 
equipment, what your interval rates are, and so on. 
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Figure 2-26. Media Scheduling-Policy Settings Window

To access the Media Scheduling-Policy Settings window click the Policy Settings 
button (Figure 2-27). 

Figure 2-27. Policy Settings Button

Room Matrix Settings

The Room Matrix Settings allows you to create and edit a matrix for Media 
Scheduling Rooms. 

Creating a New Room Matrix

The procedure for creating a new Room Matrix is shown in Procedure 2-20, 
Creating a New Room Matrix, on page 2-28.
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Procedure  2-20.  Creating a New Room Matrix

Use the following to create a new room matrix.

1. Click the Room Tab and click the New button 

Result: This displays the Room Matrix Settings dialog box (Figure 2-28).

Figure 2-28. Room Matrix Settings dialog box

2. Enter the Settings Name in the field.

3. Check the Can book? check box if the matrix allows you to book a room.

4. Select a value and a description from the two drop down menus in the Maximum 
booking time field.

5. Click Save to save your changes to the database; click Cancel to exit without saving.

Editing a Room Matrix Setting

The procedure for editing a Room Matrix Setting is shown in Procedure 2-21, 
Editing a Room Matrix Setting, on page 2-28.

Procedure  2-21.  Editing a Room Matrix Setting

Use the following to edit Room Matrix settings.

1. Click the Room tab. Click the Edit button, then click the Setting button.
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2. Place your cursor in any of the field(s) that you want to edit and re-type the 
information.  See the section above for details on the information you can edit.

3. Click Save to save your changes to the database; click Cancel to exit without saving.

Deleting a Room Matrix Setting

The procedure for deleting a Room Matrix Setting is shown in Procedure 2-22, 
Deleting a Room Matrix, on page 2-29.

Procedure  2-22.  Deleting a Room Matrix

Use the following to delete a Room Matrix.

1. Highlight a Room Matrix by clicking it. 

2. Click the Delete button. The Delete Room Matrix Setting dialog box displays.

3. Click Yes to delete the Matrix; click No to retain the Matrix.

Equipment Matrix Settings

The Equipment Matrix Settings dialog box (Figure 2-29) allows you to configure 
an equipment matrix to be used for a policy group. Included is configurable 
information such as booking settings and fine settings.
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Figure 2-29. Equipment Matrix Settings dialog box

Creating a New Equipment Matrix

The procedure for creating a new Equipment Matrix is shown in Procedure 2-23, 
Creating a New Equipment Matrix, on page 2-30.

Procedure  2-23.  Creating a New Equipment Matrix

Use the following to create a new equipment matrix.

1. Click the Equipment tab and click the New button. 

Result: The Equipment Matrix Settings dialog box displays.

2. Enter an equipment settings name in the Settings Name field.

3. Click the Can deliver to? checkbox if you want the equipment matrix to include 
delivery.

4. Click the Can pickup? checkbox if you want the equipment matrix to include pickup.

5. In the Booking Settings section, click the Booking interval field and click the down 
arrow to display the description choices for the matrix booking interval. Select a 
choice.
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6. Click the Maximum booking time field and select a value that corresponds to the 
description that you set in the Booking interval field. This field allows you to set the 
maximum amount of time for which equipment can be booked.

7. Click the Renewal time field and select a value that corresponds to the description 
that you set in the Booking Interval field. This field allows you to set a policy for the 
amount of time for which the equipment can be renewed.

8. Click the Renewal count field and select a value for the number of times the 
equipment can be renewed.

9. In the Fine Settings section, click the Fine interval field and click the down arrow 
to display the description choices for the matrix fine settings interval. Select a choice.

10. Click the Pickup fine rate field and select a value that corresponds to the description 
that you set in the Fine interval field. This field allows you to set the value for the fines 
which are applied when equipment has not been picked up.

11. Click Delivery fine rate field and select a value that corresponds to the description 
that you set in the Fine interval field. This field allows you to set the value for the fines 
which are applied when the equipment has not been delivered.

12. Click the Maximum fine field and select a value that corresponds to the description 
that you set in the Fine interval field. This field allows you to set the value at which 
the fines stop accruing.

13. Click the Fine grace period field and select a value that corresponds to the 
description that you set in the Fine Interval field. This field allows you to set the value 
for the time that can pass before a fine begins accruing.

14. Click Save to save your changes to the database. Click Cancel to exit without 
saving.

Editing Equipment Matrix Settings

The procedure for editing Equipment Matrix Settings is shown in Procedure 2-24, 
Editing Equipment Matrix Settings, on page 2-31.

Procedure  2-24.  Editing Equipment Matrix Settings

Use the following to edit Equipment Matrix settings.
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1. Click the Equipment tab.  

2. Highlight a setting and click the Edit button.

3. Click the Settings button.

4. Place your cursor in any of the field(s) that you want to edit and re-type the 
information.  See the section above for details on the information you can edit.

5. Click Save to save your changes to the database, click Cancel to exit without saving.

Deleting an Equipment Matrix

The procedure for deleting an Equipment Matrix is shown in Procedure 2-25, 
Deleting an Equipment Matrix, on page 2-32.

Procedure  2-25.  Deleting an Equipment Matrix

Use the following to delete an Equipment Matrix.

1. Click an Equipment Matrix to highlight it. 

2. Click the Delete button. 

Result: The Delete Equipment Matrix Setting dialog box displays.

3. Click Yes to delete the Matrix; click No to retain the Matrix.

Item Matrix Settings

The Item Matrix Settings dialog box (Figure 2-30) allows you to configure an item 
matrix to be used for a policy group. Included is configurable information such as 
booking settings and fine settings.
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Figure 2-30. Item Matrix Settings dialog box

Creating a New Item Matrix

The procedure for creating a new Item Matrix is shown in Procedure 2-26, 
Creating a New Item Matrix, on page 2-33.

Procedure  2-26.  Creating a New Item Matrix

Use the following to create a new Item Matrix.

1. Click the Item tab and then click the New button.

Result: The Item Matrix Settings dialog box displays.

2. Enter a name for the item settings in the Settings Name field.

3. Select the Can Deliver to? checkbox if you want the item to be able to be delivered 
to locations.
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4. Select the Can Pickup? checkbox if you want the item to be able to be picked up.

5. In the Booking Settings section:

a. Click the Booking interval field and click the down arrow to display the 
description choices for the matrix booking interval. Select a choice.

b. Click the Maximum booking time field and select a value that 
corresponds to the description that you set in the Booking interval field. 
This field allows you to set a policy for the maximum amount of time for 
which items can be booked.

c. Click the Renewal time field and select a value that corresponds to the 
description that you set in the Booking Interval field. This field allows you to 
set a policy for the amount of time for which the items can be renewed for.

d. Click the Renewal count field and select a value for the number of times 
the items can be renewed.

6. In the Fine Settings section:

a. Click the Fine interval field and click the down arrow to display the 
description choices for the matrix fine settings interval.  Select a choice.

b. Click the Pickup fine rate field and select a value that corresponds to the 
description that you set in the Fine interval field. This field allows you to set 
the value of the fines which are applied when item(s) have not been picked 
up.

c. Click Delivery fine rate field and select a value that corresponds to the 
description that you set in the Fine interval field. This field allows you to set 
the value of the fines which are applied when the item(s) have not been 
delivered.

d. Click the Maximum fine field and select a value that corresponds to the 
description that you set in the Fine interval field. This field allows you to set 
the value of the time interval at which the fines stop accruing.

e. Click the Fine grace period field and select a value that corresponds to 
the description that you set in the Fine Interval field. This field allows you to 
set the value for the time that can pass before a fine begins accruing.

7. Select the Item Status Alerts tab (see Figure 2-31) and identify/select the item 
statuses that you want to display in the search results for media items. These same 
selected statuses also provide an alert/warning message when a media item is 
added to a booking and the item has one of the selected statuses that could affect 
availability. See Figure 2-32 for an example of the alert warning messages.
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Figure 2-31. Item Status Alerts tab
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Figure 2-32. Item Status Alerts Example

8. Click Save to save your changes to the database. Click Cancel to exit without 
saving. 

Editing Item Matrix Settings

The procedure for editing Item Matrix settings is shown in Procedure 2-27, Editing 
Item Matrix Settings, on page 2-36.

Procedure  2-27.  Editing Item Matrix Settings

Use the following to edit Item Matrix settings.

1. Click the Item tab. Click the Edit button, then click the Settings button.

2. Place your cursor in any of the field(s) that you want to edit and re-type the 
information.  See the section above for details on the information you can edit.
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3. Click Save to save your changes to the database; click Cancel to exit without saving.

Deleting an Item Matrix

The procedure for deleting an Item Matrix is shown in Procedure 2-28, Deleting an 
Item Matrix, on page 2-37.

Procedure  2-28.  Deleting an Item Matrix

Use the following to delete an Item Matrix.

1. Click an Item Matrix to highlight it. 

2. Click the Delete button. 

Result: The Delete Item Matrix Setting dialog box displays.

3. Click Yes to delete the Matrix; click No to retain the Matrix.

Policy Groups

The Media Scheduling Policy Group dialog box (Figure 2-33) is where you identify 
the locations and calendars for your Media Scheduling activities. There are 
settings and matrices that you use in your policy groups. Policy groups determine 
such things as overdue settings, patron pickup rules and how those rules and 
settings are associated with patron groups and media types. 
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Figure 2-33. Media Scheduling-Policy Groups

To access the Media Scheduling-Policy Groups window, click the Policy Groups 
button (Figure 2-34).

Figure 2-34. Policy Groups Button

See Security Profiles and Policy Groups on page A-1 for a description of the 
relationship between Security Profiles definitions and Policy Groups definitions as 
it relates to operator authorizations for Bookings and Inventory.

Creating a New Policy Group

The procedure for creating a new Policy Group is shown in Procedure 2-29, 
Creating a New Policy Group, on page 2-39.
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Procedure  2-29.  Creating a New Policy Group

Use the following to create a new policy group.

1. Click the New button to open a new policy group screen.  

Result: This opens the Policy Group Settings dialog box (Figure 2-35).

Figure 2-35. Policy Group Settings

2. Enter a name for the new policy group in the Group Name field.
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3. In the Booking section:

a. Enter a number in the Warning Interval field to set the interval in minutes.  
This interval warns you, when making a booking, whether the material 
being booked is in use within that many minutes of your booking.  This 
warning does not prevent you from making the booking.

b. Enter a number in the Block Interval field to set the interval between 
blocks in minutes.  Like the warning interval, this interval warns you, when 
making a booking, whether the material being booked is in use within that 
many minutes of your booking.  However, this block prevents you from 
making the booking.

4. In the Schedule Monitor section:

a. Enter a number in the Cancel Unclaimed box to indicate how many 
minutes after the time of pickup that a booking goes unclaimed before the 
unclaimed booking is canceled.

b. Enter a number into the Overdue Warning box to designate the number of 
minutes after which overdue bookings are placed on the Warning list in the 
Schedule Monitor.

5. In the Delivery Overnight Rules section:

a. Place a check in the Shorten at Close box in order to specify that for 
delivery bookings, where the time until closing is earlier than the time that 
the booking would normally be due, should be set to expire at closing.  An 
empty checkbox indicates that the booking should roll over till the next 
morning.

b. Place a check in the Accrue Fines and Fees box to designate whether 
overdue deliveries accrue fines and fees.

6. In the Patron Pickup Rules section:

a. Place a check in the Shorten at Close box in order to specify that for pick-
up bookings, where the time until closing is earlier than the time that the 
booking would normally be due, should be set to expire at closing.  An 
empty checkbox indicates that the booking should roll over till the next 
morning.

b. Place a check in the Accrue Fines and Fees box to designate whether 
overdue picked-up items accrue fines and fees.
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7. In the Overdue Settings section:

a. Enter a number in the First Notice box to indicate how many days after an 
item is overdue that the first notice is to be sent to the patron.

b. Enter a number in the Additional Notice Interval box to indicate how 
many days after the previous notice is sent that a subsequent notice is to 
be sent to the patron.

c. Enter a number in the Additional Notice Count box to indicate the 
maximum number of notices that is to be sent to the patron.

d. Place a check in the Allow Renew box to determine whether or not 
renewal of overdue items is allowed.

8. In the Lost Settings section:

a. Enter a number in the Lost Interval box to indicate how many days after 
an item is overdue that the item is considered lost.

b. Enter a number in the Processing Fee box to set the processing fee for 
lost items.

c. Placing a check in the Charge Maximum Fine? box sets whether the 
maximum fine is automatically charged for lost items.

9. Specify the Advanced Booking Warning Period timeframe if you plan to select the 
Advanced Booking Alert in Media Scheduling (Tools > Options > Charge/
Discharge tab). Select Minutes, Hours, or Days from the dropdown list and specify 
an amount.

Editing Settings for a Policy Group

The procedure for editing settings for a Policy Group is shown in Procedure 2-30, 
Editing Settings for a Policy Group, on page 2-41.

Procedure  2-30.  Editing Settings for a Policy Group

Use the following to edit a policy group’s settings.

1. Select a policy group and click Edit.  

Result: The Edit Policy Group box opens.

2. Click the Settings button to edit the policy group’s settings.  
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3. Click Save to preserve the settings or Cancel to discard them.  

Result: This closes the Policy Group Settings dialog.

4. Click the Close button to finish editing the policy group.

Deleting a Policy Group

The procedure for deleting a Policy Group is shown in Procedure 2-31, Deleting a 
Policy Group, on page 2-42.

Procedure  2-31.  Deleting a Policy Group

Use the following to delete a Policy Group.

1. Click a Policy Group to highlight it. 

2. Click the Delete button. 

Result: The Delete Policy Group dialog box displays.

3. Click Yes to delete the Policy Group; click No to retain the Policy Group.

Assigning the Calendar for a Policy Group

The Calendar Settings dialog box (Figure 2-36) allows you to assign calendars 
to a specific policy group.  You can assign three different sets of calendars based 
on whether the booking is for a pickup, delivery or a room in the media center or 
library.
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Figure 2-36. Calendar Settings

The procedure for assigning calendar settings is shown in Procedure 2-32, 
Assigning Calendar Settings, on page 2-43.

Procedure  2-32.  Assigning Calendar Settings

Use the following to assign calendar settings.

1. Select a policy group and click Edit.  

Result: The Edit Policy Group dialog box opens.

2. Click the Calendar button to edit the policy group’s calendar.

Result: The Calendar Settings dialog box displays.

3. Click one of the tabs to display the calendar assignments for Delivery, Pickup or 
Room bookings.

4. Click a box next to a calendar to change the assignment of the calendar to the 
location.  These calendars are defined in the System Administration module.  See 
the System Administration User’s Guide for more information about circulation 
calendars.
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NOTE:
Any changes that you make to these check boxes take effect immediately.  
Voyager does not make changes only upon exiting the dialog box.  Because of 
this, you may experience a lag between checking the box and the change 
registering while Voyager executes the change.

5. Click Close to close the Calendars dialog.

6. In the Media Scheduling window, click Close to finish editing the policy group.

Creating Locations for a Policy Group

The Locations dialog box (Figure 2-37) allows you to specify what can and 
cannot be done at a particular location.  You can include location properties such 
as whether bookings can be made from here, whether items can be picked up 
here, default settings for items being created at this location, and so on.

Figure 2-37. Locations Settings

The procedure for creating locations for a Policy Group is shown in Procedure 2-
33, Creating Locations for a Policy Group, on page 2-45.
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Procedure  2-33.  Creating Locations for a Policy Group

Use the following to create new locations for a policy group.

1. Select a policy group and click Edit.  The Edit Policy Group box opens.

2. Click the Locations button.  

Result: This opens the Locations dialog for that policy group.

3. Click the New button.  The Locations dialog displays the Select Locations to Add 
block.  These locations are created and defined in the System Administration 
module.  For more information on Locations, see the System Administration User’s 
Guide. 

4. Select a location to add and click the Next> button.

5. Place a check in the Booking Desk? checkbox to establish this location as a 
location where bookings can be made.  Placing a check in this field causes the 
Notice and Report Print Location, Brief Record Creation, and Other Stuff blocks 
to display.

6. Place a check in the Pickup Point? checkbox to establish this location as a location 
where bookings can be made.  Placing a check in this field causes the Brief Record 
Creation and Other Stuff blocks to display.

7. Select the happening location for any booking activity from the Notice and Report 
Print Location drop-down menu.

8. In the Brief Record Creation section, place a check in the Suppress Bib 
Records? checkbox to suppress newly created bibliographic records from 
displaying in WebVoyage.

9. Specify the default item type for newly created items by selecting from the Item Type 
drop-down menu.

10. Specify the default location for newly created items by selecting from the Location 
drop-down menu.

11. In the Delivery/Return Time (Minutes) section, enter the time it normally takes for 
the room to be set up in the Setup/Delivery Time field by clicking the up/down arrow 
buttons or by typing the time directly into the field.
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12. Enter the time it normally takes for the room to be cleaned up in the Cleanup/Return 
Time field by clicking the up/down arrow buttons or by typing the time directly into the 
field.

13. In the Other Stuff section, place a check in the Delivery Staging? checkbox to 
indicate that the location is to be used for staging deliveries.

14. Place a check in the Collect Fines? checkbox to indicate that the location is 
permitted to collect fines.

15. Enter the time that it takes to shelve items at this location by clicking the up/down 
arrow buttons next to the digit in the Shelving Time field and selecting the 
increments from the units drop-down menu.  You can also type the time directly into 
the field.

16. Enter the number of days that items are generally in transit from this location by 
clicking the up/down arrow buttons by the digit in the In Transit Days field and 
selecting the increments from the units drop-down menu.

17. Click Finish to save the settings or Cancel to discard them.

18. In the Locations dialog, click Close.  This closes the dialog box.

19. In the Media Scheduling window, click Close to finish editing the policy group.

NOTE:
For the media equipment booking request form to display in WebVoyáge, the 
OPAC Circ Desk selection in Circulation - Cluster Maintenance (see Figure 2-38) 
must be included in the Media Scheduling - Policy Groups (see Figure 2-39 and 
Figure 2-40).
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Figure 2-38. Voyager System Administration Circulation - Cluster Maintenance
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Figure 2-39. Media Scheduling - Policy Groups

Figure 2-40. Media Scheduling - Policy Groups Locations setup

Editing Locations for a Policy Group

The procedure for editing locations for a Policy Group is shown in Procedure 2-34, 
Editing Locations for a Policy Group, on page 2-49.
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Procedure  2-34.  Editing Locations for a Policy Group

Use the following to edit the settings for a particular location.

1. Select a policy group and click Edit.  

Result: The Edit Policy Group dialog box opens.

2. Click the Locations button.  

Result: This opens the Locations dialog for that policy group.

3. Select the location that you want to edit and click the Edit button.  

Result: The Locations dialog displays the settings for that location.

4. Edit the settings for the location.

5. Click Save to preserve the settings or Cancel to discard them.

6. In the Locations dialog, click Close.  

Result: This closes the dialog box.

7. In the Media Scheduling window, click Close to finish editing the policy group.

Deleting a Location

Locations deleted from the Voyager Media System Administration module are are 
not completely deleted.  The locations are deleted from the records in Voyager 
Media System Administration. However, they remain active in the System 
Administration module.  To completely delete a location, you must delete it in the 
System Administration module.  For more information, see the Voyager System 
Administration User’s Guide.

The procedure for deleting a location is shown in Procedure 2-35, Deleting a 
Location, on page 2-50.
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Procedure  2-35.  Deleting a Location

Use the following to delete a Location.

1. Click to highlight a Location. 

2. Click the Delete button. 

Result: The Delete Location dialog box displays.

3. Click Yes to delete the Location or click No to retain the Location.

Result: This saves or cancels the location request.

Policy Group Matrix Assignments

The Policy Group Matrix Assignments dialog box (Figure 2-41) allows you to 
determine what policy group is applied to a particular transaction.  Based on the 
patron group and the type of room, equipment or item, you can specify that a 
particular Policy Matrix Settings group is used.  You can make assignments for 
Room types, Equipment types and Item types.  You can create new assignments, 
change existing ones and delete outdated ones.

The Room matrix allows you to specify what policy group should be applied to any 
room-related aspects of a transaction.  This can be defined based on the Media 
Room Type and the patron group of the person submitting the request.  You may 
create assignments for any combination of Room Types and patron groups.  
Rooms in Voyager Media Scheduling are assigned to a specific Media Room Type 
by setting the Room Type drop-down menu on the Details tab of the Room record 
in the Voyager Media Scheduling module. 

The Equipment matrix allows you to specify what policy group should be applied 
to any equipment-related aspects of a transaction.  This can be defined based on 
the Equipment Type and the patron group of the person submitting the request.  
You may create assignments for any combination of Equipment Types and patron 
groups.  Equipment in Voyager Media Scheduling is assigned to a specific 
Equipment Type by setting the Equipment Type drop-down menu on the Details 
tab of the Equipment record in the Voyager Media Scheduling module. 

The Item matrix allows you to specify what policy group should be applied to any 
item-related aspects of a transaction.  (Items are the media added to a transaction 
on the Media tab of the request.)  This can be defined based on the Media Type 
and the patron group of the person submitting the request.  You may create 
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assignments for any combination of Media Types and patron groups.  Media (i.e., 
items) in Voyager Media Scheduling are assigned to a specific Media Type by 
setting the Media Type drop-down menu of the item record (either through the 
Cataloging module or the Circulation module). 

Assignments can be made to specific combinations of Patron Groups and Media/
Media Room/Equipment Types or globally to all Patron Groups and/or all Media/
Media Room/Equipment Types.

Figure 2-41. Policy Group Matrix Assignments-Room tab

• Click the Room, Item or Equipment tabs to view or change assignments 
for Rooms, Items or Equipment, respectively.

• To close the Policy Group Matrix Assignments dialog box, click the Close 
button.

Creating a New Matrix Group

The procedure for creating a new Matrix Group is shown in Procedure 2-36, 
Creating a New Matrix Group, on page 2-52.
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Procedure  2-36.  Creating a New Matrix Group

Use the following to create a new Matrix Assignments group.

1. Click the tab for the type that you want to associate with a patron group and a group 
of policy settings.

2. Click New.  

Result: The New Matrix Assignments dialog box displays.

3. Select the Type and Patron Group you want to associate, and choose a Settings 
category that you want to be assigned when that combination occurs.

4. Click Save to keep your changes and close the dialog box; click Cancel to discard 
them.

Editing a Matrix Group

The procedure for editing a Matrix Group is shown in Procedure 2-37, Editing a 
Matrix Group, on page 2-52.

Procedure  2-37.  Editing a Matrix Group

Use the following to edit an existing Matrix Assignments group.

1. Click the tab for the type that you want to associate with a patron group and a group 
of policy settings.

2. Select the profile you want to edit.

3. Click Edit.  

Result: The Edit Matrix Assignments dialog box displays.

4. Change the settings that are to be applied to the displayed Type and Patron Group.

5. Click Save to keep your changes and close the dialog box; click Cancel to discard 
them.



 Ex Libris Confidential 10.2 2-53

Chapter 2: Using Media System Administration

Deleting a Matrix Group

The procedure for deleting a Matrix Group is shown in Procedure 2-38, Deleting a 
Matrix Group, on page 2-53.

Procedure  2-38.  Deleting a Matrix Group

Use the following to delete an existing Matrix Assignments group.

1. Click the tab for the type that you want to associate with a patron group and a group 
of policy settings.

2. Select the type you want to delete.

3. Click Delete.

Policy Group Rules

In the Policy Group Rules dialog box, you can establish rules for different kinds of 
Patron Groups and for Room, Equipment and Media Types.  You can create 
different sets of rules for every single type.  Each set of rules is associated with a 
particular Patron Group, Media Room Type, Equipment Type or Media Type.  
Rules can be created for specific Patron Groups, Media Types, Media Room 
Types, or Equipment Types or globally for all Patron Groups, Media Types, Media 
Room Types, and/or Equipment Types.

Patron Group Rules

The Patron Group Rules dialog box (Figure 2-42) lists all of the patron groups 
created in the System Administration module.  For more information on patron 
groups, see the System Administration User’s Guide.
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Figure 2-42. Policy Group Rules - Patron Group Tab

• The procedure for creating rules for a Patron Group is shown in 
Procedure 2-39, Creating New Rules for a Patron Group, on page 2-54.

• The procedure for editing rules for a Patron Group is shown in 
Procedure 2-40, Editing Rules for a Patron Group, on page 2-56.

• The procedure for deleting rules for a Patron Group is shown in 
Procedure 2-41, Deleting Rules for a Patron Group, on page 2-56.

Procedure  2-39.  Creating New Rules for a Patron Group

Use the following to create rules for a Patron Group.

1. Click the New button.  

Result: The Add Patron Group block displays.

2. Select the Patron Group that you want to add.  Click the Next> button.  The Patron 
Group Rules block displays.
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3. Set rules for patron groups in the Patron Group Rules dialog box.  If any are grayed 
out, this rule is not subject to change for the selected patron group.  You can set the 
following rules.

Field Name Description

Patron Group 
Requestable 
using OPAC?

Select this option to permit patrons in this patron group to 
make requests using the OPAC.

Overlapping 
Bookings?

Determines whether or not overlapping bookings by a 
patron of this type are allowed.

Fines Apply? Sets whether fines apply to this patron group.

Fees Apply? Sets whether fees apply to members of this patron group.

Early Pickup 
Window?

Determines how early before the time for which a booking is 
requested that it may be charged out.

Optional 
Maximums 
section

NOTE:
These options may be turned on and off using the checkbox 
at the left of each option.

Outstanding 
Balance

Sets a maximum outstanding balance.

Number of 
Bookings

Sets the maximum number of bookings by a patron.

Items in a 
Booking

Sets the maximum number of items in a booking.

Pieces of 
Equipment in 
a Booking

Sets the maximum number of pieces of equipment that can 
be charged in a booking.

Late Returns Sets the maximum number of late returns.

Canceled 
Bookings

Sets the maximum number of canceled bookings.

Unclaimed 
Bookings

Sets the maximum number of unclaimed bookings.

4. Click the Finish button to save the rules; click the Back button to change the Patron 
Group; or click Cancel to discard changes.
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5. Click the Finish button when you are done editing the patron group rules.  Click 
<Back to change the Patron Group.  Click Cancel to discard changes and close the 
block.

Procedure  2-40.  Editing Rules for a Patron Group

Use the following to change the rules for a Patron Group.

1. Select a Patron Group from the list and click Edit.  

Result: The Patron Group Rules block displays.

2. Edit the rules for patron groups in the Patron Group Rules dialog box.

3. Click the Save button when you are done editing the patron group rules or click 
Cancel to discard changes and close the block.

Procedure  2-41.  Deleting Rules for a Patron Group

Use the following to delete a set of rules for a particular patron group.

1. Click a Patron Group.

2. Click Delete.

3. In the Delete Patron Group confirmation dialog box, click Yes to delete the rules or 
No to not delete the rules.

Room Type Rules

The Room Type Rules dialog box (Figure 2-43) lists all of the room types defined 
in the Media Room Type screens.  For more information, see Media Room Types 
on page 2-20.
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Figure 2-43. Policy Group Rules - Room Tab

• The procedure for creating rules for a Room Type is shown in Procedure 2-
42, Creating Rules for a new Room Type, on page 2-57.

• The procedure for editing rules for a Room Type is shown in Procedure 2-
43, Editing Rules for a Room Type, on page 2-58.

• The procedure for deleting rules for a Room Type is shown in Procedure 2-
44, Deleting Rules for a Room Type, on page 2-58.

Procedure  2-42.  Creating Rules for a new Room Type

Use the following to create rules for a new Room Type.

1. Click the New button.  

Result: The Add Room Type block displays.

2. Select the Room Type that you want to add.  Click the Next> button.  The Room 
Type Rules block displays.
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3. If the room can be scheduled by the Voyager Media Scheduling module put a check 
in the System Scheduled? checkbox.  If the equipment in the room can be 
delivered to other locations, place a check in the Can Deliver? checkbox.

4. Click the Finish button when you are done editing the room rules.  Click <Back to 
change the Room Type.  Click Cancel to discard changes and close the block.

Procedure  2-43.  Editing Rules for a Room Type

Use the following to change the rules for a Room Type.

1. Select a Room Type from the list and click Edit.  

Result: The Room Type Rules block displays.

2. If the room can be scheduled by the Voyager Media Scheduling module put a check 
in the System Scheduled? checkbox.  If the equipment in the room can be 
delivered to other locations, place a check in the Can Deliver? checkbox.

3. Click the Save button when you are done editing the room rules.  Click Cancel to 
discard changes and close the block.

Procedure  2-44.  Deleting Rules for a Room Type

Use the following to delete a set of rules for a particular room type.

1. Click a Room Type.

2. Click Delete.

3. In the Delete Room confirmation dialog box, click Yes to delete the rules or No to 
not delete the rules.

Equipment Type Rules

The Equipment Type Rules dialog box (Figure 2-44) lists all of the equipment 
types defined in the Equipment Types screen.  For more information, see 
Equipment Types on page 2-12.
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Figure 2-44. Policy Group Rules - Equipment Tab

• The procedure for creating rules for an Equipment Type is shown in 
Procedure 2-45, Creating New Rules for an Equipment Type, on 
page 2-59.

• The procedure for editing rules for an Equipment Type is shown in 
Procedure 2-46, Editing Rules for an Equipment Type, on page 2-60.

• The procedure for deleting rules for an Equipment Type is shown in 
Procedure 2-47, Delete Rules for an Equipment Type, on page 2-61.

Procedure  2-45.  Creating New Rules for an Equipment Type

Use the following steps to add rules for a new equipment type.

1. Click the New button.  

Result: The Add Equipment Type block displays.

2. Select an equipment type and click Next>.  

Result: The Equipment Type Rules dialog box displays.
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3. Set the rules for the Equipment Type selected.  See Table 2-2.  

Result: The options are selected for the Equipment Type Rules.

4. Click the Finish, <Back, or Cancel.

Result: This allows you to save, edit, or cancel the Equipment Type Rules 
options.

Procedure  2-46.  Editing Rules for an Equipment Type

Use the following to edit the rules for an equipment type.

1. Select the Equipment Type and click the Edit button.  

Result: The Equipment Type Rules workspace displays.

2. Enter a dollar value into the Default Replacement Value cell.  Enter the time in 
minutes it takes to deliver and set up the equipment into the Setup Time (minutes) 
cell.  Enter the time it takes to pack and return the equipment into the Cleanup Time 
(minutes) cell.

3. Click the Save button to save the rules or click Cancel to discard your changes.

Table 2-2. Equipment Type Rules

Options Description

Equipment Type Displays the equipment type selected for editing 
rules.

Default Replacement 
Value

Enter the dollar value representing the 
replacement cost for this equipment type.

Setup Time (minutes) Enter the time in minutes required to setup the 
equipment type selected.

Cleanup Time (minutes) Enter the time in minutes required to pack up and 
return the equipment selected.

Equipment type 
Requestable using OPAC?

Select this option to indicate that this type of 
equipment is requestable through the OPAC.
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Procedure  2-47.  Delete Rules for an Equipment Type

Use the following to delete the rules for an equipment type.

1. Select the equipment type.

2. Click Delete.

3. In the Delete Equipment confirmation dialog box, click Yes to delete the rules or No 
to not delete the rules.

Media Type Rules

The Media Type Rules dialog box (Figure 2-45) lists all of the media types in the 
Media Types screen.  For more information on Media Types, see Media Types on 
page 2-15.

Figure 2-45. Policy Group Rules - Media Tab

• The procedure for creating rules for a Media Type is shown in Procedure 2-
48, Creating Rules for a Media Type, on page 2-62.
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• The procedure for editing rules for a Media Type is shown in Procedure 2-
49, Editing Rules for a Media Type, on page 2-62.

• The procedure for deleting rules for a Media Type is shown in Procedure 2-
50, Deleting Rules for a Media Type, on page 2-63.

Procedure  2-48.  Creating Rules for a Media Type

Use the following steps to add rules for a new media type.

1. Click the New button.  

Result: The Add Media Type block displays.

2. Select a media type and click Next>.  

Result: The Media Type Rules dialog box displays.

3. Set the rules for the Media Type selected.  See Table 2-3. 

Result: The options are selected for the Media Type Rules.

4. Click the Finish, <Back, or Cancel.

Result: This allows you to save, edit, or cancel the Media Type Rules options.

Procedure  2-49.  Editing Rules for a Media Type

Use the following to edit the rules for a media type.

1. Select the Media Type and click the Edit button.  

Table 2-3. Media Type Rules

Options Description

Default Replacement 
Value

Enter the dollar value representing the 
replacement cost for this media type.

Media type Requestable 
using OPAC?

Select this option to indicate that this type of 
media is requestable through the OPAC.
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Result: The Media Type Rules workspace displays.

2. Enter a dollar value into the Default Replacement Value cell.

3. Click the Save button to save the rules, or click Cancel to discard your changes.

Procedure  2-50.  Deleting Rules for a Media Type

Use the following to delete the rules for a media type.

1. Select the media type.

2. Click Delete.

3. In the Delete Media confirmation dialog box, click Yes to delete the rules or No to 
not delete the rules.

Policy Group Media

The Media Type dialog box (Figure 2-46) allows you to set a hierarchy of 
equipment types for each media type in a policy group.  This allows you to specify 
what equipment is suggested to accompany a particular kind of media and what 
order in which they display. For example, if someone is charging out a videotape, 
you would want to suggest that they might need a VCR, or a TV, or an AV cart, or 
a TV/VCR unit.  

In the Media Types dialog box, you can establish a list of media types, for each of 
which you can create a list of compatible equipment.  This list displays under the 
Media Item Types for Booking option in the Media Equipment block on the 
Equipment tab of the booking.
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Figure 2-46. Media Types - Equipment List Dialog Box

The procedure for editing a hierarchy for a media type is shown in Procedure 2-
51, Edit a Hierarchy for a Media Type, on page 2-64.

Procedure  2-51.  Edit a Hierarchy for a Media Type

Use the following to edit a hierarchy for a media type.

1. Highlight a media type and click the Edit button.  

Result: The Equipment Types Hierarchy block opens.

2. Place a check mark in the box next to the equipment types that you want to be 
related to this media type.  Deselect the check box to remove it from the list.

3. Arrange the hierarchy of equipment types with equipment types that can read the 
media type with the most useful equipment at the top of the list.  You can move items 
up and down in the list by highlighting the item and clicking the up and down arrows.  
This is the order in which the categories display in the list in the booking dialog box.
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4. Click Save when you are done ordering the equipment types; click Cancel to discard 
your changes.

5. Click Close when you are done editing media rules.

Menu Items

The following menus display when you open the Voyager Media System 
Administration module. 

File

The File menu contains the functions shown in Table 2-4.  

Functions

The Functions menu contains the functions shown in Table 2-5.  

Table 2-4. File Menu

Login Info displays the login operator’s name and 
ID and location

Exit closes this session of Media System 
Administration

Table 2-5. Functions Menu

Operator 
Security

switches the view to one of the Operator 
Security screens: Security Profiles, 
Locations, or Operators

Media 
Scheduling

switches the view to one of the Media 
Scheduling screens: Equipment, Media, 
Maintenance, Media Room, or Media 
Room Detail Types; Policy Settings; or 
Policy Groups
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Help

The Help menu contains the functions shown in Table 2-6.  

Table 2-6. Help Menu

Help Topics displays the table of contents for Media 
System Administration and opens the 
Help window

Endeavor on 
the Web

connects to Endeavor Support Web or to 
the Endeavor home page

About Sys-
tem Adminis-
tration

displays information on the Media Sys-
tem Administration module
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Security Profiles and Policy Groups

Introduction

The security profiles and policy groups defiinitions determine operator 
authorization for the following:

• Viewing/processing equipment.

• Viewing/processing rooms.

• Viewing/processing items.

The following guidelines apply when setting these definitions.

• Locations always determine when a room or equipment can be viewed/
processed in.

• The policy group the operator is logged into must provide authorization to 
the same location as specified in the  definitions in order to book an item, 
room, or equipment.  Otherwise, the warning message "Item belongs to a 
foreign policy group" displays.  This message can be overridden and the 
booking can be completed.

• When the location is not specified in both the  and  definitions, the operator 
cannot process inventory or book items, rooms, and equipment.

The following tables summarize the operator authorizations for the different 
combinations of settings in the Security Profiles and Policy Groups definitions.

• Table A-1contains information on Item Authorizations.

• Table A-2contains information on Room Authorizations.
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• Table A-3 contains information on Equipment Authorizations.

Table A-1. Item authorizations

Y Y Booking allowed

Y N Booking allowed with override

N Y Booking allowed

N N No booking allowed

Table A-2. Room authorizations

Y Y
Booking allowed

Inventory privileges

Y N
Booking allowed with override

Inventory privileges

N Y
Booking allowed

No inventory privileges

N N
No booking allowed

No inventory privileges

Table A-3. Equipment authorizations

Y Y
Booking allowed

Inventory privileges

Y N
Booking allowed with override

Inventory privileges

N Y
Booking allowed

No inventory privileges
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Appendix A: Security Profiles and Policy Groups

The Policy Groups definition is determined by the login location the operator 
selects when signing on to the Media Scheduling module.

N N
No booking allowed

No inventory privileges

Table A-3. Equipment authorizations
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